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AutoCAD programını nasıl çalıştırız ? 
 
Masa üstünde yandaki simge farenin sol tuşu ile çift tıklanarak veya 
Başlat → Programlar→Autodesk→AutoCAD2004→AutoCAD2004 simgesi tıklanır 
 
Program çalıştıktan sonra aşağıda görülen pencere karşımıza çıkar.  
Oklarla gösterilen öğeleri kullandıkça öğreneceğiz. Şimdilik sadece isimlerini ve konumlarını bilmemiz 
yeterlidir. 
 

 

 
 
AutoCAD programını öğrenirken kullanılan araçları tek tek ele alıp incelemek yerine, çizilmesi amaçlanan 
nesnelerin oluşturulması sırasında gerekli araçların nasıl kullanılacağını öğreneceğiz. Bu şekilde nesnelerin en 
kısa ve kolay yolla nasıl çizileceğini öğreneceğiz. Çizimlerde ihtiyaç duyacağımız araçlar arttıkça gerekli 
detaylara değineceğiz  
 
Hazırladığımız bu dokümanda öncelikle temel çizim esaslarını öğrenmeye çalışacağız. AutoCAD programı çok 
kapsamlı olduğu için  detaylı bilgiler piyasada mevcut kitaplarda bulunabilir. 
 
Bu bilgilerden sonra çizime başlayabiliriz.  
 

Status Line 
(Durum Gösterge satırı) 

Command Line 
(Komut Satırı) 

İmlecin Koordinat 
Göstergesi (X,Y,Z) 

Toolbars 
(Araç Çubukları) 

Crosshair (Cursor) 
(İmleç) 

Main Menu 
(Ana Menü) 

WCS - UCS 
(Koordinat Sistemi) 

Drawing File 
(Aktif Çizim Dosyası ) 

Grid 
(Çizim Alanı Izgarası) 
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Teknik Resim dersinde bir çizime başlarken ilk önce çizim kâğıdını hazırlarız. Kâğıdımızın boyutları aşağıda 
belirtilen standart boyutlardan birinde olur. 

A serisi Boyutlar(mmxmm) 
A0 841,1189 
A1 594,841 
A2 420,594  
A3 297,420 
A4 297, 210 
A5 148,210 
A6 105,148 

AutoCAD programında da standart kağıt boyutlarına benzer şekilde öncelikle çizim sınırlarının (DRAWING 
LIMITS) oluşturulması gerekir.  
 
Çizim sınırlarının oluşturulması: 
 
Klavyede F7 (tuşuna bastığımızda) ekranda daha önceden belirlenmiş çizim sınırları, 
noktalardan oluşan ızgara (GRID) şeklinde ekrana gelir. Tekrar F7 tuşuna basılırsa 
ızgaranın kaybolduğu görülür. Aynı anda alt kısımda bulunan durum çubuğunda basılı  
olan GRID simgesinin F7 tuşuna bağlı olarak pasif veya aktif hale geldiği gözlenir. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Bundan sonra üstteki menü çubuğunda  Format → Drawing Limits seçilir.  
Komut satırında: 
Specify lower left corner  <0,0000, 0.0000>: 
(çizim sınırının alt sol köşesinin koordinatlarının girilmesini belirten üstteki yazı çıkar. 
Köşeli parantez içindeki kısım en alt köşenin  koordinatlarının 0,0 olarak önerildiğini kabul 
etmemiz halinde Enter tuşuna ↵ basarız. Aksi halde başka bir değer girmemiz 
gerekir. 
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0,0 değerini çizim sınırlarının sol alt köşesi olarak kabul ederek  ↵ tuşuna basarız. Daha sonra komut 
satırında aşağıda belirtilen bir başka yazı çıkar. 

 
 
  
 
 

Specify upper right corner <420.000, 297.0000>: 
çizim sınırlarının üst sağ köşesinin koordinatlarını girmemiz istenmektedir. Biz çizim sınırlarını  
A4(210,297) olarak belirleyeceğimiz için üst köşenin koordinatlarını 210,297 yazıp ↵  
tuşuna basarız. 
Bu anda ekranda görülen ızgaranın boyutlarının değiştiğini görürüz. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Ekranın sol alt kısmında bulunan çizim sınırlarının tamamını ekranda daha büyük görmek için ZOOM komutunu 
kullanacağız. Bunun için imleç omut satırında iken 
 
Command: z (Zoom komutunun ilk harfi) ↵  
All/Center/Dynamic/Extens/Previous/Scale/Window]<real time>: a ↵  
 

 
Aynı işlemi 2.yol olarak: 
Üst menüde View→Zoom→All yolunu izleyerek 
gerçekleştirebiliriz. 
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Bu işlemden sonra çizim sınırlarını oluşturan ızgara aşağıdaki gibi görülür. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Çizim alanı içerisinde Anted çizgilerini oluşturmak. 
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Antet çizgilerini oluşturmak için LINE komutunu kullanmamız gerekir.  
AutoCAD’te bir komutu kullanmanın bir kaç yolu vardır.  
1.yol: 
Komut satırına komutunun tamamını veya ilk harfini ( aynı harfle başlayan komutlarda, komutun  ilk iki harfini 
veya ilk üç harfini) yazarak 
 
Command: L (line)  
 

2.Yol: Araç çubuğundaki komut simgesi ile  

 
 
3.Yol: Üst menüden komutun bulunduğu bölüme girerek.  
 
Örneğin: Line komutu için 
Üst menüden Draw→Line  
 
 
Biz komut satırını kullanacağız. 
 
Command: L ↵ 
LINE specify first point: 20,5  ↵   (1 noktasının koordinatlarını çizginin başlangıç noktası olarak 

belirliyoruz) 
Specify next point or [undo]: 205,5 ↵ (2 noktasının koordinatlarını yazıyoruz. Yanlış yazılırsa u yazıp 

↵ tuşuna basarsak bir önceki noktaya döneriz.) 
 
Specify next point or [undo]: 205, 292 ↵ ( 3 noktasının koordinatları) 
 
Specify next point or [undo]: 20, 292 ↵ (4 noktasının koordinatları) 
 
Specify next point or [undo]: 20,5 ↵ ( başlangıç noktasının koordinatlarını yazıyoruz)  

yada C yazıp enter tuşuna basarak başlangıç noktası ile birleştiriyoruz. 
 
Specify next point or [undo]: ↵ ( başka bir noktaya gitmeyeceğimiz için ↵ Enter tuşuna basıyoruz) 
 
Command: 
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Antedin diğer kısımlarını ve antet yazılarını daha sonra tamamlamak üzere şimdi aşağıdaki şekli çizmeye 
çalışalım. 
 
Çizim alanının üst kısmını yakından görmek için araç çubuklarında ZOOM realtime simgesi seçilir. 
Simge çizim alanı içerisinde iken farenin sol tuşu basılı tutularak yukarı ve aşağı doğru hareket 
ettirilirse ekrandaki nesnelerin yakınlaştığını veya uzaklaştığını görürüz. İmleç yukarı doğru hareket ettirilirse 
nesneler yakınlaşır, imleç aşağı doğru sürüklenirse nesneler uzaklaşır.  
 
Belirli bir yakınlaştırmadan sonra ekrandaki görüntüyü kaydırmak  için imlecin sağ tuşu tıklanır. Çıkan 
pencerede Pan seçilir. Bundan sonra ekranda el simgesi çıkar. Bu simge çıktığı anda farenin  sol  tuşu 
basılı halde sağa,sola, yukarı ve aşağı sürüklenirse görüntünün kayması sağlanır. Sonra tekrar sağ tuş 
tıklanıp çıkan pencerede Exit seçilirse ZOOM realtime komutundan çıkılır. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Kullanılan fare (Mouse) tekerlekli ise tekerleği yukarı aşağı doğru hareket ettirerek Zoom Realtime 
komutunda olduğu gibi nesnelerin yakın veya uzak görünümü sağlanır. Yakınlaşma ve uzaklaşma sırasında 
imlecin bulunduğu nokta merkez alınır.  
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LINE komutunu kullanarak çizim alanının üst kısmında herhangi bir nokta, çizginin başlangıç noktası olarak 
işaretlenir. 
Command:l ↵ 
Specify first point: herhangi bir nokta işaretlenir. 
Specify next point or [undo]: çizginin uç noktasının koordinatlarının girilmesi isteniyor. Aşağıdaki 
şekle bakılırsa imlecin herhangi bir doğrultuda hareket ettiğini görürüz.  
F8 (=ORTHO) tuşuna basıp imleci hareket ettirirsek. İmlecin çapraz gitmeyip sadece düşey ve yatay 
doğrultuda hareket ettiğini görürüz. F8 tuşuna tekrar basıp imleci hareket ettirirsek , imleç 
çaprak olarak hareket eder. Bu esnada F7(=GRID) ayarında olduğu gibi F8 (=ORTHO) 
ayarrının aktif olup olmadığı durum çubuğundaki ORTHO simgesinden anlaşılır. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
F8 tuşuna basıp imlecinyatay hareket etmesisağlandıktansonra aşağıdaki satıra dikdörtgenin yatay 
uzunluğunu (80) yazıp ↵  
Specify next point or [undo]: 80 ↵ 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
İmleci düşey olarak hareket ettirdikten sonra aşağıdaki satıra dikdörtgenin düşey uzunluğu (50) yazılır. 
 
Specify next point or [undo]: 50 ↵ 
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İmleç yatay olarak hareket ettirildikten sonra dikdörtgenin üst yatay uzunluğu (80) yazılır. 
Specify next point or [undo]: 80 ↵ 

 
 
Çizginin ucunu başlangıç noktası ile birleştirmek için ya düşey uzunluk yazılır veya c ( close=kapat) yazılıp ↵ 
tuşuna basılır. 
 
Specify next point or [undo]: 50 ↵   Specify next point or [undo]: c ↵ 
                    veya 
Specify next point or [undo]:  ↵   Command: 
 

Command: 
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Soru: Çizdiğimiz dikdörtgenin üst kenarının ortasından alt kenarının ortasına bir çizgi çizmek istiyoruz. Ne 
yapmamız gerekir? 
 
Cevap: OSNAP ayarlarını kullanmamız gerekir?  
 
OSNAP ( Object Snap) çizilen nesnelerin ( çizgi, çember, yay gibi) belirli noktalarının yakalanmasını sağlayan 
bir araçtır.  Osnap yardımcı bir olup sadece komutlarla birlikte kullanıldığı zaman nesnelerin belirlenen 
noktalarının yakalanmasını sağlar.  
 
Şimdi sorumuzun cevabını bulmaya çalışalım. 
 
Önce OSNAP ayarlarından Mid Point(=orta noktayı) işaretlememiz gerekir. İmleç durum 

çubuğundaki OSNAP simgesi  üzerinde iken farenin sağ tuşuna bastığımızda 
yandaki pencere çıkar. Settings seçilirse  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
Yukarıdaki pencerede 
Endpoint:  Uç nokta 
Midpoint:  Orta nokta 
Center:    Çemberin merkezi 
Node:      Point komutu ile oluşturulmuş nokta 
Quadrant: Bir çemberin çeyreğini oluşturan nokta 
İntersection: İki objenin kesişim noktası 
Extension: Objelerin uzantısı 
İnsertion: Yerleşim noktası 
Perpendicular: Dikey nokta 
Tangent: Bir nesneye teğet nokta 
Nearest: en yakın nokta 
Apparent Intersection: İki nesnenin zahiri kesişim noktası 
Paralel: Bir nesneye paralel nokta  
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Yukarıdaki pencerede şimdilik sadece Midpoint seçilir. OSNAP ayarlarının aktif olması için F3 tuşu kullanılır 
veya yukarıdaki  � Object Snap On (F3) kutucuğu işaretlenir. Ok e basılarak pencere kapatılır. 
İmleci dikdörtgenin üst yatay kenarına temas ettirdiğimizde nesnenin orta noktasını yakalamadığını görürüz. 
Nedeni ise biraz önce bahsettiğimiz gibi bu ayarlar bir komutla beraber çalışır. 
 
Dikey çizgi çizmek için  
 
Command: l ↵ 
Specify first point : şimdi imleci, dikdörtgenin üst yatay kenarına temas tıkladığımızda otomatik olarak 

üst kenarın ortası yakalanır. Bunu ortada beliren küçük bir üçgen simgesinden anlarız.  
Specify next point: Aynı şekilde dikdörtgenin alt kenarına imleç tıklanırsa orta kısım otomatik olarak 

seçilmiş olur.   
Specify first point: ↵  (enter tuşuna basılarak komut sonlandırılır) 
 

Command: 
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OFFSET:  
Bir çizgiyi, bir çemberi veya kapalı bir nesneyi  , nesneye paralel olarak belirlenen bir mesafeye kopyalamak 
için çok sık kullanılan  bir komuttur.  
Komutun uygulanışını yukarıdaki şeklimizde ortaya çizdiğimiz düşey çizgiyi , 15 mm lik mesafelerle çizginin 
sağına ve soluna offsetleyelim (kopyalayalım) 

       
 
Command: O ↵                                Yada üst menüden Modify → Offset  
 

veya araç çubuğunda   
 

 
                 

 
OFFSET specify ofset distance or Through:   15  ↵( çizginin kopyalanacağı 
mesafe yazılır.) 
Select object to ofset: kopyalanacak obje seçilir  

 
 
 
 
 
 
 
 
 
 
 

Specify point on side to ofset:  Objenin kopyalanacağı tarafta herhangi bir nokta belirlenir. 

 
 

Select object to ofset: 
 

 
 
 
 
 
 
 
 
 
 

Specify point on side to ofset:  Objenin kopyalanacağı tarafta herhangi bir nokta belirlenir. 
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OFFSET ayarlarını 10 mm olarak değiştirerek şeklin diğer aşağıdaki gibi oluştururuz. 
 

  
 

Soru: Yukarıda soldaki şekildeki fazlalıkları silerek sağdaki şekli elde etmek için hangi komutu kullanmalıyız ? 
 
Nesneleri seçip klavyede Delete tuşuna basarsak seçtiğimiz objeler silinir. Fakat biz yukarıda nesnelerin 
fazla kısımlarını silmek istiyoruz. Bunun için aşağıdaki komutu kullanmalıyız. 
 
  TRIM: (Budamak)     (veya  simgesi seçilir)  
 
Command: tr  
Select object: ↵  ( entere basılır) 
Select object to trim shift select to extend or [Project/Edge/Undo]: Nesnelerin 
istenmeyen kısımlarını seçeriz. 
 

 
 
Not: İşlem sırasında yanlışlıkla silinen kısımları geri almak için yanlış hareket sonrası “u” yazıp↵ tuşuna 
basarız. 
 
Not: 
Trimleme sırasında okla belirtilen çizginin silinmediğini fark 
ederiz.  
Trim komutu ile çizgilerin başka bir çizgiyi geçen kısımlarını 
silebiliriz. 
Okla  gösterilen dikey çizginin başka çizgiyi geçen kısmı 
olmadığı için bu  çizgi trim komutu ile silinemez. 
Çizgiyi silmek  için çizgiyi seçip,klavyede Delete tuşuna 
basarız. 
 
Soru: 
Çizdiğimiz şeklin tamamını çizim alanının başka bir yerine nasıl taşıyabiliriz ? 
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Cevap: MOVE: (=taşıma)   komutu veya simgesini kullanarak seçtiğimiz nesneleri istediğimiz yere taşırız. 
İmleç çizilen şeklin sol üst köşesinde herhangi bir noktaya (1 noktası) tıklanır. Sonra sağ alt köşede 
herhangi bir noktaya (2 noktası) tıklanır.  
  

 
 
 
 
 
 
 
 
 
 

Seçilen nesnelerin üzerinde küçük kutucuklar ortaya çıkar. Her bir çizginin üzerinde üç adet küçük kutucuk 
bulunur.  
Daha sonra farenin sağ tuşuna basılırsa aşağıdaki pencere ortaya çıkar. Pencerede Move (taşıma) komutunu 
seçeriz. İmlec ile  şeklin üzerinde herhangi bir nokta 
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İmleç ile parça üzerinde herhangi bir nokta işaretlenir. 
Daha sonra imleç hareket ettirilerek taşınacak nokta belirlenir. 
İmleç, sadece düşey veya yatay hareket ediyor ise F8 tuşuna basarak ORTHO ayarını devre dışı bırakırız. 
Bu durumda imlecin çapraz hareket etmesi sağlanmış olur. 

 
YATAYLA  AÇI YAPAN  ÇİZGİ ÇİZMEK  
Durum  çubuğu üzerindeki POLAR simgesi üzerinde iken farenin sağ tuşuna basar, çıkan pencerede 
Settings (ayarlar) seçeriz. 

 
 

 

 
 
Çıkan pencerede yukarıda belirtildiği gibi düzenlemeler yapılarak OK tuşuna basılır. 
 
Line komutunu kullanarak yatayla 50° açı yapan çizgiyi çizebiliriz. 
 
Command: l 
Specify first point: okla gösterilen noktayı 
yakalamak için daha önce belirtildiği gibi OSNAP 
ayarlarından endpoint veya intersection işeretlenir. 
 
İmleç o nokta üzerine getirilerek tıklanır. 
 
Çizginin başlangıç noktası belirlenmiş olur. 
İmleci hareket ettirirsek aşağıda gösterildiği gibi 
çizginin yatayla yaptığı açının 10° lik artışla değişti 
gini izleriz.  

 
 
 
 

Açısal İzlemeyi etkinleştirmek 
için kutucuk işaretlenir veya F10 
tuşunu kullanırız. 

Oku kullanarak açıların artış 
miktarlarını belirleriz. (10 ° seçildi) 

Tüm açı değerlerinin izlenmesini 
sağlar. 

Açıların yatay çizgiden itibaren 
ölçülmesini sağlar.(Açı ölçerde 
olduğu gibi) 
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Şekilde görülen Polar:30.7171<50° ifadesi ;  çizginin yatayla 50° lik açı yaptığını ve uzunluğunun 
30.7171  olduğunu belirtir. 
 
Specify next point: 
 İmleçi yukarı doğru hareket ettirerek 50° lik açı ve herhangi bir uzunluğa geldiği noktayı tıklarız. 
 
 

Specify next point: ↵  
 
Command: 
 
 
 
 
 
 
 
 
 
 
 
 
 
Aynı işlemi sol taraftaki açı için de 
yaparız. Bu kez yatayla 130° açıyı 
dikkate almamız gerekir. 
 
 
 
 
 
 
 
 
 
 
 
Fazla kısımları TRIM komutu ile 
silerek aşağıdaki şekli oluştururuz. 
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Şeklin kenarlarında KAVİS  FILLET:  ve PAH CHAMFER :oluşturnak: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Yarıçapı 12 mm olan kavisi oluşturmak için: 

Command: F ↵    veya simgesi seçilir. 
 

Select first object or [Polyline/Radius/Trim/mUltiple]: R ↵ (avisin yarıçapını belirlemek için  
 

Specify fillet radius <0.0000>: 12 ↵ 
 

Select first object or [Polyline/Radius/Trim/mUltiple]: once düşey kenar seçilir. 
 

Select second object: daha sonra yatay kenar seçilir. 
 
 
 
 
 
 
 
 

 
Yatay uzunluğu 8 mm, düşey uzunluğu 12 mmolan PAH’ ı oluşturmak için: 
 

Command: cha ↵   veya  simgesi seçilir. 
CHAMFER 
(TRIM mode) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000 
 

Select first line or [Polyline/Distance/Angle/Trim/Method/mUltiple]: d↵ 
 

Specify first chamfer distance <0.0000>: 8↵ 
 

Specify second chamfer distance <8.0000>: 12↵ 
 

Select first line or [Polyline/Distance/Angle/Trim/Method/mUltiple] 
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Soru: 
Çizdiğimiz parçayı aşağıdaki şekilde nasıl tarayabiliriz ? 
 

 

 
 
 
 
Cevap: HATCH komutunu kullanarak tarama işlemini yaparız. 
 

Command: h ↵  veya  simgesini seçersek aşağıdaki tarama penceresi çıkar. 
 
Tarama modelini değiştirmek için 
Swatch ile belirtilen kutusunu 
seçeriz. 
 

 
 
 
Çıkan pencerede ANSI seçilir. 
ANSI131 tarama modeli 
seçildikten sonra OK simgesine 
basılır.  
Tekrar tarama penceresi çıkar. Bu 
pencerede Pick Points simgesi 
seçilir.  Parçada taranması istenen bölgeler seçilir.  
Enter tuşuna basıldıktan sonra yukarıdaki tarama penceresinde OK seçilirse seçilen bölgelerin taranmış 
olduğu görülür.  

Sayfa 18



Bilgisayar Destekli Tasarım Ders Notları 

 

 18

Soru: 
Tarama çizgilerinin aralığını nasıl değiştirebiliriz? 
 
Tarama penceresindeki Scale (ölçek) kısmındaki değeri küçültüp 
büyülterek tarama çizgi aralığını değiştirebiliriz. 
 
 
 
 
 
 
 
 
 

Scale: 0.25    Scale: 2     Scale: 1 
 
 
 
 
 
 
 
 
 

Soru: 
Tarama çizgilerinin açıları nasıl değiştirebiliriz? 
 
Tarama penceresindeki Scale (ölçek) kısmındaki değeri küçültüp büyülterek tarama çizgi aralığını 
değiştirebiliriz. 
 
 
 
 
 
 
 
 
Angle: 0    Angle: 90   Angle: 45 

 

  
 
  

Not: Tarama penceresindeki  Preview (ön izleme)  simgesini seçerek tarama çizgilerinde yapılan 
değişikliklerin uygulanmadan önce görülmesi sağlanır.  
Pick or press Esc to return to dialog or <Right-click to accept hatch>:  
Tarama çizgileri uygun görülürse klavyede ↵ tuşuna basılır. Değişiklik yapılmak istenirse Esc tuşuna basarız.  
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Soru: 
Şeklin ortasındaki düşey çizgiyi eksen çizgisi haline nasıl dönüştürebiliriz.? 
 
 
Aşağıdaki işlemleri uygulayarak  düşey çizgiyi eksen çizgisi biçimine dönüştürelim. 

 
 

Layers araç çubuğundaki  simgesi seçilirse veya Komut satırına  La (Layer) yazılırsa aşağıdaki pencere 
çıkar.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Layer 1 yazısının olduğu kutucuğun içine Eksen yazarız. 

 
Eksen çizgisinebir renk atamak için Color sütunundaki White 
yazısı tıklanır. Açılan renk penceresinden bir renk seçilir. 
 
OK simgesi seçilir. 
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Eksen çizginin çizgi biçimi olarak atanan düz çizgiyi (continuous) eksen çizgisi(Center) ile değiştirmek için 
Linetype ( çizgi biçimi) sütunundaki  Continuous  tıklanır. 

 
 
 
 
 
 
 
 

Çıkan Çizgi biçimi Seç ( Select Linetype) penceresinde , program kütüphanesindeki çizgi biçimlerini görmek 
ve sonra yüklemek için Load simgesi  seçilir. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Çıkan Load or Reload Linetypes (Çizgi tiplerini yükleme veya yeniden yükleme) penceresinde Center çizgi 
biçimini seçer, OK simgesini tıklarız.  
Yeni açılan Select Linetype (Çizgi biçimi seç) penceresinde CENTER eksen biçimini seçer OK simgesini 
tıklarız. 

 
Layer penceresinde çizgi biçiminin CENTER(eksen) olarak değiştiğini görürüz. 
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Şimdi eksen çizgisinin kalınlığını 0.25 mm (A4 boyutundaki kağıtlarda parça çizgisinin kalınlığı 0.5 mm, 
eksen çizgi kalınlığı ise 0.25 mm olarak standartlaştırılmıştır.) olarak belirleyelim. 
 
Layer penceresinde  CeNTER yazısının yanında Lineweight (çizgi kalınlığı) sütunundaki Default yazısı seçilir. 

  
Çıkan Lineweight (çizgi kalınlığı)penceresinde 0.25 mm değeri seçilir. OK simgesi tıklanır. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Karşımıza tekrar Layer penceresi çıkar.  

 
 
Eksen çizgi laınlığının 0.25 mm olarak değiştiği görülür. 
 
Şimdiye kadar çizdiğimiz çizgiler O(sıfır) layerinde çizildiği için şekli  oluşturan çizgilerin kalınlığını  0.5 mm 
olarak değiştirmemiz gerekir. Biraz önceki adımları izleyerek şeklin çizgi kalınlığını 0.5 mm olarak değiştiririz. 
Bundan sonra karşımıza çıkan Layer penceresinde OK basarak çizim alanına döneriz. 
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Düşey çizgiyi seçtikten sonra  Layers araç çubuğundaki O (sıfır)layer seçilirse açılan listede eksen seçilir. 

 
 

 
 
Düşey çizginin  eksen çizgisi haline dönüşmesi gerekir. Fakat aşağıda olduğu gibi eksen çizgisi halinde 
görülmüyorsa veya eksen çizgi aralığı çok büyük yada küçükse aşağıdaki işlemin yapılması gerekir..  
 

 
 
 
 
 
 
 
 
 
 
 
 

Eksen çizgisi çift tıklanır.  
Ekrana gelen  Properties (özellikler) penceresinde Linetype 
scale ( çizgi biçimi ölçeği) nin karşısındaki 1 sayısı seçilir. 
Sıfırdan küçük bir değer yazılır. Seçilen çizginin eksen  
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Çizgisi halinde görülmesi sağlanır. Biz 0.25 yazıp eksen çizgi aralığını kontrol edelim.  
 
Bundan sonra ESC tuşuna basarak çizginin özelliği görülür. 
Eksen çizgisinin ölçeğinin 0.25 mm olması çizginin görülmesini sağladı.bu değer daha büyük veya daha 
küçük olarak değiştirilebilir. 
 

 
Soru: 
Şeklin çizgi kalınlığını 0.5mm ve eksen çizgi kalınlığını 0.25 mm olarak değiştirdiğimiz halde  tüm çizgiler 
aynı kalınlıkta görülmektedir. Çizgi kalınlıklarını nasıl görebiliriz ? 
  
Cevap: 

Durum çubuğundaki LWT simgesine   basılırsa eksen ve şekli oluşturan çizgilerin 
belirlediğimiz gibi farklı kalınlıklarda olduğu görülür. İmleci ,simge üzerine getirdiğimizde Show/Hide 
Lineweight ( çizgi kalınlığını Göster/Gizle) yazısı ortaya çıkar. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
Görüldüğü gibi tarama çizgileri ile  parça çizgileri aynı kalınlıktadır. Bilindiği gibi tarama çizgi kalınlığı daha 
ince olup 0.25 mm olmalıdır.  
 
Yukarıda belirtilen işlemleri uygulayarak tarama isimli yeni bir layer oluşturur, çizgi biçimini Continuous ,çizgi 
kalınlığını 0.25 mm ve çizgi rengini herhangi bir renk olarak belirlersek tarama çizgileri, parça çizgilerinden 
farklı özelliklerde olur. 
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